InsideBusiness Connect Client -
Installation Guide (Windows)

Disclaimer: No part of this document may be used or reproduced in any form or by any means without the

permission of the document owner.
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Introduction

This document describes the installation of the InsideBusiness Connect Client (IBCC) on a Windows system. It
follows a step-by-step approach with screenshots.

What does it do?

IBCC offers you an easy and safe solution for the automated processing of large transaction files. It gives you
direct access to ING’s European network for sending payment orders and receiving reports.

What is it?

IBCC is the new ING Wholesale Banking application that allows the customer to easily connect with ING
InsideBusiness Connect. This is a Java program that runs as a service and establishes a safe, host-to-host
connectivity between your ERP system and ING and ensures safe, fast and automated processing of
transaction and report files.

The application provides folders (incoming and outgoing) for the customers to drop their payments files which
will automatically be uploaded to ING. Reporting files are generated and are automatically downloaded. They
can be picked up for reconciliation purposes by the ERP system of the customer.

Files can be delivered to and collected from IBCC 24 Hours a day, 7 days a week (24x7).

Foundation and Generic modules

® Easy installation via Wizard

® Configuration via GUI

® Application heartbeat monitoring

® Secure connection via SFTP

® Automated upload every second

® Automated download every 15 minutes
® Regular updates via Wizard

Version

If a version of IBCC is already installed, you can verify it via the standard windows tools: Control Panel /
Programs & Features. Search for the name InsideBusiness Connect Client.

Installation Requirements

Account Requirements

The user needs to have an FTP account as well as customer certificates that obtain during the ING onboarding
process.

Installer Rights

The installer and GUI need to be executed by a user with administrator rights.

Technical environment
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The IBCC software needs to be installed on the customer’s server. The installation is done via an installation
wizard and configuration GUI where the customer is prompted for SFTP configuration information, namely a
Logon ID (provided by ING) and a DS certificate (obtained via ING PKI or a third party). The IBCC software is
supported on the following operating systems:

®* Windows 10, 11
® Windows server 2012 (R2), 2016, 2019, 2022

Support for Windows 7 has ended as it is no longer supported by Microsoft.

Installation and transfer directory

Secure the transfer and configuration directories from unauthorized access before you start using IBCC.
Untrusted parties must not be able to read or write the data directories or the properties file.

The minimal required space for the installation of the software is 200 MB. File size for the created directories
depends on the customer usage. The following directories are created inside the Transfer directory specified in
the configuration GUI Welcome screen:

® upload: Payment files dropped here will be encrypted and sent to ING for processing.
® download: Decrypted Reporting files are placed here for reconciliation by the customers ERP system
¢ archive: Successful sent Payment files are archived here

The required space on disk depends on the size of the payment files. For a single transfer a minimum amount
of twice the size of a payment file is needed.

As transferred payment files are kept in the archive directory, this directory must have enough free space to
hold the payment files.

For example: For a yearly archive of monthly payments the required disk space is at least 12x the maximum
payment file size.

By default, the archive directory will never be purged and all succeeded transfer will be kept in the folder. A
purge mechanism is in place and can be configured via the IBCC configuration GUI. Please see the
configuration GUI documentation for more details.

Upload folders

You will need one or more upload folders. Manage these in the Folders tab.

Specify as many upload folders as you like. IBCC will upload files as they appear in any of them. To avoid
confusion, the GUI will not accept the same folder being listed more than once.

Each upload folder is associated with a particular product type. The default is PAYMENT, but if your contract
includes Virtual Ledger Accounts, you can also set up separate folders for VLA uploads and you can use
FACTCLT to send files to FactorLink.

Save (Ctrl+s) your GUI changes before using the new folders. This will automatically restart the service and
create the designated subfolders in each upload folder.

IBCC works with upload folders you provide; it does not create the upload folders. Nor does it remove them
from the file system when you deactivate them. It only creates the subfolders.

Atomic writes
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When you (or your ERP software) writes a file into an upload folder, this must happen atomically. Otherwise,
IBCC would have no reliable way to know whether the file is complete. Your ERP package may still be writing
to it, or something may have gone wrong.

Therefore, ensure that the file is first written to a temporary location on the same physical drive as the target
location, and then once it has been written completely, it should be moved or renamed to its definite location.

The IBCC service will ignore temporary files in the upload folders, so one way of doing this would be to start
by writing the file under a name which marks it as temporary, and finally, changing its name.

Temporary files are defined as follows:

® They are hidden
® They end with the .tmp extension

Here is an example, in pseudocode, of how a file should correctly end up in the upload folder:

copy input file into upload/input file.{uuid}.tnp
move (or renane) upload/input file.{uuid}.tnp to upload/input file (this operation is ato

We recommend including some random characters (e.g. a UUID or GUID) in the temporary file name, to avoid
accidental overwrites in the case where you may write multiple files into the upload folder simultaneously.

Logon User

The Logon User is the Windows user running the IBCC service. By default, the Logon User is the standard
Windows user Local Service. It has the minimal privileges to be able to start a Windows service.

Important: For that reason, it might happen that the Logon User Local Service does not have access to the
desired transfer folders. This will prevent the IBCC service from starting until permissions are given to Local
Service to access the transfer folders, or until a new Logon User is configured to run the IBCC service.

Even though the default Logon User Local Service will work in most scenarios, it is advised to change it to a
user with specific privileges.

In a case requiring the transfer folders to be on a network share, the default Logon User Local Service will
most likely not have access to it. A new Logon User with access to the network share has to be configured to
run the IBCC service.

In any case, it is very important for the Logon User to have access to both Installation and Transfer
directories, otherwise the service might not start.

Changing the Logon User under which the IBCC service is running
This is a default Windows administration procedure. It can be done easily from the service panel, as follows:

1. Navigate to the service: Control Panel -> Administrative Tools -> Services.
2. Locate the ‘InsideBusinessConnectSvc’ service, right-click and view the ‘Properties’.
3. Gotothe ‘Log On’ tab and change the user as desired.

Heartbeat monitoring

The IBCC service is sending heartbeats to the ING server every 1 hour.
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Installing

The installation process of the IBCC is quite simple. It consists of:

® |IBCC Setup Wizard
® |IBCC Configuration GUI

The step-by-step explanation and images will guide you through the process of setting up the software on your
computer.

Starting the installer
To start the installer in a Windows environment, run IBCC_windows_{version}.exe as an administrator.
Before the setup process begins, you might be prompted with a User Account Control window for confirmation.

Press Yes in order to continue.

Installation process - Setup Wizard
The first screen shown is the Welcome Screen.
Press Next in order to continue.

The following screen displays the License Agreement to the user, either in plain text or in HTML. The license
agreement must be accepted to continue the installation.

Press Next in order to continue.

The next screen is to Select Destination Directory where you would like the IBCC to be installed. Here you can
change the default installation directory.

Press Next in order to continue.

Important: Since IBCC runs as a Windows service, it is required for the IBCC installation folder to be available
when the machine starts up and for the Logon User to have access to it. In other words, it is recommended to
use the default installation location. Using a network share for that purpose will most likely not work.

In the next screen it is possible to Select Start Menu Folder in which you would like to create the program’s
shortcuts, or to disable their creation.

Press Next in order to continue.

From there, the program will begin copying application files and Installing IBCC on your computer.
Once that is done a screen appears confirming the installation of IBCC is finished.

Press Finish in order to exit.

Important: The latest Java 1.8.0 Runtime Environment is bundled with the application. BellSoft’s build was
used during development and testing. Use of any other JRE implementation may lead to unwanted behaviors.

Configuration process - GUI
Introduction
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The purpose of the GUI application is to help the customer set up the configuration of IBCC service.

Once the Setup Wizard is completed, the GUI will automatically start. To start the GUI manually, run it as an
administrator from the IBCC Start Menu group.

Namely: InsideBusiness Connect Client > Configure InsideBusiness Connect Client
Before the GUI begins, you might be prompted with a User Account Control window for confirmation.

Press Yes in order to continue.

Configuration Setup screen
Upon start the Configuration Setup screen is shown, containing mandatory elements for initial setup:

® Environment

® Data signing key
® LogonID

®* Transfer folder

The first important configuration element is the ING Environment. Acceptance is selected by default.

The customer Data signing key (.pfx or .p12 extension) for the chosen environment has to be imported. After
selecting the file a prompt window appears requesting customer password input. This key will be used to add
digital signature to the files that will be sent to ING. The password is obfuscated before saving it.

ING envirenments available ba cannect to |.I'|I!I!!PII'.|I‘|I!E for new customers)

Environment | Accephance -

Data signing key {.pfx) that is used to sign files before sending to ING
ot signineg ey

-

B Cats signmg key passwiord =

Flease enter the possward Tor your data sigring key a

TITRTITITR]

Show possward

The next field is the Logon ID, which is communicated beforehand by ING.
Finally, the user has to select the IBCC Transfer folder.
Once all fields are set accordingly and valid the configuration can be confirmed.

Press the Confirm new configuration button to continue.
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Notes:

® Text fields that contain paths to mapped drives are converted to UNC paths when applicable.

® However, it is possible to paste UNC paths directly (e.g. in a case of a transfer folder pointing to a
network share). In that case, no check will be performed.

®* A new SSH key pair required for authentication against ING IBCC server will be generated in the
background. This might take a few seconds. Actions on this SSH key are available in the Connection
tab.

® The SSH public key and SSH fingerprint have to be known to ING. They can be exported in the
Connection tab.

ING envirenments available ba cannect to |.I'|I!I!!PII'.|I‘|I!E for new customers)

Environment | Accephance -

Data signing key {.pfx) that is used to sign files before sending to ING

ot HOrIneg Hey | Chdetidownlond i BLC_testioartshds pfx

Unique ING sarvar customar account 1D (providad by ING)

Logen 1D | FTEADS18

Lecation of the InzideBusiness Cannect Client transfer directory

Transfer fokder | Chbransfer_folder

Main screen

The Main screen is divided into the following tabs:

® |nfo

®* Folders

® Connection
® Security

Info
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InsideBusiness Connect Client

E Version 1.10-5# ntallotion ID
Erveir et CCRLIanCe
Faldars
Service stotus RUNNING Logon user NT AUTHORITYLocalService

@ Lost errorat 141805451

Connactian

Security

The Info tab displays the following information:

® Version - current running version of IBCC

® |Installation ID - unique customer installation ID

® Environment - ING SFTP server endpoint

® Service status - running/stopping/stopped/starting

® Logon user - Windows user running the IBCC service

® |ast error log - timestamp of the most recent IBCC service daily error

Notes:

®* The Save prompt window pops up when starting the service if there are pending configuration changes.
Press OK in order to accept.

® Once the IBCC service is started and running 3 folders are created (if not already existing) under the
transfer directory: upload, download and archive.

® By default, the IBCC service will run under the default Windows Local Service user. This can be
changed.

® |BCC service logs are archived daily.

Folders

The Folders tab displays the following elements:

® Upload directory (editable text field)
®* Download directory (editable text field)
® Use subdirectories - use same reporting folder structure as ING SFTP server (Default: off)
® Archive mode - data archiving behaviours:
® Forever(Default) - files remain indefinitely in the archiving directory.
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® With retention time - files will be deleted from the archiving directory if older than the given

retention time (default: 168 hours). When selected, a text field shows on the right for the user to
enter a retention time in hours.

® Never - files are deleted after successful upload and therefore never archived. Archive directory
text field is hidden.

® Archive directory (editable text field)

Notes:

® Transfer folder text fields will be highlighted in red if the path is invalid or does not exist.

® |f transfer folders are located on a network share, it is possible that the user running the Configuration
GUI application (the currently logged on user) does not have access to the network share and cannot

browse to it.

2 InsideBusiness Connect Clisnt - ConfiGui

File  Help

Infor

Etnrngn Snﬂ:inﬂ:

e ]

Upload directory

Upload directory

Chboch transfersyupload

Chjboctransfersyupload vla

@ Download directory | Cbectransfersydownload E
w'| Llse sub-folders
Connection
m Archive mode  Farewer -
Security Archive directory | Chilbec\fransfarsharchive E
Connection
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Connection succeeded

The Connection tab displays the following elements:

® Server - ING SFTP server endpoint
® Logon ID (editable text field)
® SSH private key - SSH authentication private key location
® SSH key fingerprint - SSH authentication public key fingerprint
® Retry failed uploads - retry mechanism behaviours:
® Never(Default) - failed upload will not be retried and will remain in the upload/error/ folder
® For delay - failed uploads will be retried for a certain delay after which they will end up in the
upload/error/ folder
® Forever - failed uploads will be retried forever and will never end up in the upload/error/ folder
® HTTP proxy - HTTP proxy management status (enabled/disabled)
® Server - HTTP proxy endpoint
® Port - HTTP proxy port
® User - HTTP proxy username
® Password - HTTP proxy password
® Test connection (Test connection result)

Important: The SFTP test connection process is ran by the currently logged on user (user running the GUI).
This may be important when, e.g. running behind a proxy the user running the GUI needs to be able to access
the proxy server (as well as the user running the service - Logon user). If the proxy is not reachable in that
scenario, the test connection might time out or return an error. Solutions are described in the Common
Problems section.

The Connection tab allows for the following configuration actions:

® SFTP connection configuration:
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® Import an SSH private key by pressing the Import PRIVATE key button. Select a private key in
the file dialog. A matching .pub key should be present in the same directory.

® Export the current SSH private key to the Desktop by pressing the Export PRIVATE key button.
This file should NOT be sent to ING. It can be useful when migrating the IBCC installation to a
different machine for instance.

® Export the current SSH public key and fingerprint as a zip archive to the Desktop by pressing the
Export PUBLIC key and fingerprint button. This file should be sent to ING after the initial setup as
well as upon generation of a new SSH private key.

® HTTP Proxy configuration: if the customer machine is running behind a proxy, an appropriate
configuration is needed.

® To enable the HTTP proxy management for the IBCC application, use the enable check box.
®* When enabled, you can then configure the following:
® HTTP proxy server (default: localhost)
® HTTP proxy port (default: 8080)
® HTTP proxy user (Note: leave blank if the proxy does not require authentication, same for
the below password)
® HTTP proxy password (Note: the password will be obfuscated before saving it)

Notes:

® |f the SSH private key is generated by PUTTY Key Generator, it has to be exported as SSH2 (Namely:
Conversions > Export OpenSSH key).

® A notice window pops up when importing an SSH private key before overriding the existing one. Press
OK in order to continue.

® A prompt window pops up when importing a protected SSH private key, requesting customer password
input. The password is obfuscated before saving it.

® A notice window pops up when exporting the current SSH private key to the users Desktop (*id_ibcc*).

® A notice window pops up when exporting the current SSH public key and fingerprint to the users Desktop
(*IBCCPubExport_<logon id>_<environment>_<date>.zip*).

Security

The Security tab displays the following elements:

® Data signing key - used to sign content before uploading to ING SFTP Server.
® Import a data signing key by pressing the Import data signing key button.

® ING certificate
® Import an ING certificate by pressing the Import ING certificate for current environment button.
® Export the current ING certificate by pressing the Export ING certificate for current environment

button.
Notes:

® A prompt window pops up when importing a data signing key, requesting customer password input. The
password is obfuscated before saving it.

® A notice window pops up when importing an ING certificate before overriding the existing one.

® A notice window pops up when exporting the current ING certificate to the users Desktop
(*ING_cert_<Environment>.cer*).
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Menu bar
File

The File menu contains the following items:

® Save - a prompt window pops up before saving all pending configuration changes to the properties file.

Press OK in order to accept.

S [nzideBusiness Cornect Chent - Confilul

Chaonges hove been detected.
e Yo sure you want to save?
There are 2 gending chongas.

Product folders usage to chonga Tnom [fose] to [rae]
S5H priwota key to be importac from (S FrogromDatonsidebasness Connact Cl

- | Hide Detolls
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® Discard - a prompt window pops up before discarding all pending configuration changes. Press OK in
order to accept.

S [nzideBusimess Correct Chent - Confilu

fire Ll Sure you want to decard Laur I'hﬂll'l-.}F":"'

Thera are 2 gending chonges.

Product folders usage to chongs fram [fose] to [trae]
Z3H priwota key to b2 dmnportac from [CFregromDatoinsideBasiness Connect CU

“ | Hide Detolls

® Reset - a prompt window pops up before discarding all pending configuration changes and resetting the
configuration to default. Press OK in order to accept.

S [nzideBusivess Corract Chent - Confiul

Are Ll SUre You want to reset Lour I'l.‘.\"lrlgl.. ratian?

There are 2 gending chonges.

Product folders usage to chongs Tnom [fose] to [rue]
S5H priwiate key to b= inportad from LS ProgramnDatonsideBasness Connact Cl

“ | Hide Datolls

® Quit - a prompt window pops up offering the following actions:
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® Discard and Quit - discard all pending configuration changes and quit application.
® Save and Quit - save all pending configuration changes and quit application.

i [nzideBusivess Cornect Clent - Confilul

Chonges hove been detected,
Wit do you want to do?

There are 2 gending chongas.

Product fokders usawge to chonge Tnom [fose] to [rae]
S5H priwata Key o b2 dnportad from (CPregramDatoinsideBasiness Connact CU

- | Hile Detolls Dlscord & Quis e B Quit

Note: the IBCC service will be restarted upon saving the configuration changes to the properties file.

Help

The Help menu contains the IBCC Installation Guide in the form of a web page. You can also open it using the
shortcut F1.
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Uninstalling

The IBCC provides the user with an Uninstaller Wizard.

Starting the uninstaller

The Uninstaller Wizard can be found in the Programs and Features entry in the Control Panel, or simply in the
IBCC group Start Menu shortcut.

Namely: InsideBusiness Connect Client > Uninstall InsideBusiness Connect Client
The User Access Control window might pop up requesting confirmation.

Press Yes in order to continue.

Uninstallation process

The installation process of the IBCC is straightforward and is explained step by step below. The first screen is
simply a confirmation of uninstallation.

Press Next in order to continue.

During the uninstallation a prompt window will appear inquiring whether to delete existing log files. Once that is
decided upon a screen appears confirming the IBCC is successfully removed from your computer.

Press Finish in order to exit.

Note: In case the user wants to completely re-install the IBCC, he needs to have it successfully uninstalled
first, otherwise the installer will start in update mode.
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Updating

When a new release is available, launching its installation wizard will trigger an update of the already installed
version. While running the update, several steps from the installation explained above are skipped.

Starting the updater
To start the installer for an update, run the new IBCC_windows_{version}.exe as an administrator.
Before the setup process begins, you might be prompted with a User Account Control window for confirmation.

Press Yes in order to continue.

Updating process
The first screen shown is the Welcome Screen.
Press Next in order to continue.

If a previous installation is detected, the user will be prompted with a confirmation screen in order to proceed
with the update.

Press Next in order to continue.

By doing an update, the previous version is first uninstalled behind the scenes (but the configuration is kept as
is), and the new one is installed. Once that is done a screen appears confirming the IBCC is updated and
ready. The service is restarted automatically.

Press Finish in order to exit.
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Troubleshooting

The IBCC service and configuration GUI will log data in the following directory:

%ProgrambData%\InsideBusiness Connect Client\log\

This is the first place to look in case of problems.

Common problems

The service does not start (either from the Configuration GUI or the Service Panel)

Most likely it is a permission issue. The Logon User does not have access to the transfer folders. If this is the
case, inspecting the service logs (*daemon.log*), will reveal error messages such as AccessDeniedException
or FileAlreadyExistsException. If no logging is available at that moment, refer to the next common problem
No logging is available.

Solution: Either change the Logon User for a user that has access to the transfer folders, or explicitly give
permissions to the current Logon User to have Full Control on the transfer folders.

No logging is available

When no logging data is available in the folder %ProgramData%\InsideBusiness Connect Client\log\
several causes can be possible.

® The logging config file points to a location that does not exist. Solution: edit the file %ProgramData%
\InsideBusiness Connect Client\log4j2.xml and change the file value.

® The logging config file points to a location that the Logon User cannot access. Solution: give full control
to the logging target location to the Logon User.

The above will likely occur when IBCC was updated from a version prior to 1.4. Before version 1.4, the logging
location was in the transfer folder as well. After an update to version 1.4 or above, the Logon User was set to
the default Local Service and this user might not have access to the target logging location set formerly in the
transfer folder.

The IBCC service can connect to ING SFTP server but not the Configuration GUI

Sometimes the Configuration GUI Test Connection feature will return an error message, however the IBCC
service runs fine and can connect to ING. This will most likely happen when using an HTTP proxy. The reason
is that the current user that started the Configuration GUI cannot access the proxy server, but the Logon User
can so the IBCC service runs fine.

Solution: Either start the Configuration GUI as the Logon User, or give the current user access to the proxy
server.

Log messages
All the messages below are identified by a unique ID.

IBCC service
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059b657¢

f233eec?
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63468fca

4466f4db

fcaab123

dealea2c

523cld2c

An error occurred while loading the property file. The property file (*icb.properties*) from
configuration directory is not present or not accessible.

An error occurred while setting up the security context. Possible problems with ING or customer
certificate (.pfx). Please see log file for detailed error.

An error occurred while uploading IBCC service heartbeat. Possible problems with generating
heartbeat content.

An error occurred while purging archive directory. Possible problems with service user access
rights to transfer directory. Please check the IBCC service user.

An error occurred while signing the file. Possible problems with data-signing key (.pfx). Please
see log file for detailed error.

An error occurred while encrypting the file. Possible problems with incompatible encryption
algorithm or encoding. Please see log file for detailed error.

Failed to decrypt file. The received file was not properly encrypted or encrypted with unexpected
parameters. Please see log file for detailed error.

Failed to verify file. The received file might have been signed by an untrusted source, or its
signature is invalid. Please see log file for detailed error.

General upload error. Please investigate the logs for more detailed messages.

Failed SFTP connection while uploading file. Please investigate the logs for more detailed
messages.

Failed SFTP remote operation while attempting to upload a file. The requested remote directory
might not exist or its access might be forbidden.

Transfer was interrupted when uploading a file. It can be due to network or connectivity issues.
Please see log file for detailed error.

General download error. Please investigate the logs for more detailed messages.

Failed SFTP connection while attempting to download file(s). Please investigate the logs for
more detailed messages.

Failed SFTP remote operation while attempting to download file(s). The requested path might
not exist or its access might be forbidden.

Transfer was interrupted when downloading a file. It can be due to network or connectivity
issues. Please see log file for detailed error.
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Fallback scenario

Please contact ING for information regarding the fallback procedure.
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